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Title in Times New Roman (TNR) 20 Bold: 

Capitalise Content Words 
 

Forename (or initials) Surname in TNR 11 Bold 

Institution in TNR 11 Italics 

 

Abstract (TNR 9 bold). Include an abstract of a maximum of 250 words in plain 

TNR 9 (not bold/underlined/italicised) here, indented on both sides by 3cm. (If your 

ruler is in inches, you can change it to centimetres: in Word, go to 

File>Options>Advanced, scroll down to the Display heading, and change “Show 

measurements in units of” to centimetres.) There should be two line spaces at TNR 

11 both preceding and following your abstract. All text should be formatted with 

1.15 line spacing, including this abstract. The abstract should be followed by a 

single, page-width line that can be achieved by typing a full line of the 

minus/underscore symbol ‘-’.  

 

 

 

1 First-level Heading in TNR 16 Bold: As in the Title 
 

Number your headings and leave a ‘Tab’-length space (use whatever Word/the software has set as the 

default: usually this is 1.27cm) between the number and the heading. Do not end the number with a full 

stop/period and ensure the heading number is not indented. Capitalise all content words in all levels of 

headings. Follow a colon with a capital letter. Paragraphs should be aligned with ‘Justify’ (not ‘Left 

Aligned’ or ‘Right Aligned’) No text should have space before or after paragraph, including titles; i.e., 

under ‘Line and Paragraph Spacing’ (located to the right of alignment options) in ‘Paragraph’ in Word, 

it should read ‘Add Space Before Paragraph’ and ‘Add Space After Paragraph’. 

 

1.1 Second-level Heading in TNR 14 Bold 

 

Note that this and the subsequent level of heading are in smaller font,  TNR 14. For all headings, please 

leave a single line break between them and the body text which follows. 

 

1.1.1 Third-level Heading in TNR 12 Italics 

 

The only difference between this and the above level heading is in the numbering. Please note that it 

may not be necessary to use three levels of heading. Generally speaking, the fewer the levels of heading, 

the better. Do not go beyond three levels of heading. 

 

2 Layout 
 

The margins should be set at 1 inch (2.54cm) all around, which may be the default setting (check in 

Word via: Page Layout>Margins>Normal). Do not include page numbering or any headers or footers 

(but see Section 3.1 on footnotes). Note that the first paragraph following a title, list, table, figure should 

not be indented; only paragraphs following the first one of a section, list, table, etc. should be indented. 
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2.1 Paragraph Formatting 

 

The first paragraph following a heading is not indented. The body text of your article should be in TNR 

11 throughout (except for when you need to use other fonts for linguistic purposes). All paragraph text 

should be aligned using ‘Justify’. 

The following paragraphs (all of those after the first) of a section are indented by 1cm. Again, if 

your ruler is in inches, you can change it to centimetres: go to File>Options>Advanced, scroll down to 

the Display heading, and change ‘Show measurements in units of’ to centimetres. 

 

3 Style 
 

3.1 Footnotes 

 

Footnotes should only be used to clarify or add additional relevant information to a point being 

expressed in the main text. They should not be used as a means to make a separate point away from 

what the text discusses. Thus, footnotes should ideally be used sparingly, if at all. Do not use them to 

provide referencing details (which should all be given in the end references, including website 

addresses). If you feel that it is necessary to include a footnote, then please ensure that you insert the 

superscript number following any punctuation. Preferably, the footnote should come at the end of a 

sentence, as here1 (with the superscript preceding the full stop/period). Please do not use endnotes. 

 

3.2 Use of Language  

 

3.2.1 The World’s Englishes 

 

Because this is the Journal of the Undergraduate Linguistics Association of Britain, we would kindly 

ask authors to stick to British English spellings where applicable. The same point can be applied to 

decimal notation: please refer to decimals using a full stop or period (i.e., ‘16.8’, as opposed to ‘16,8’). 

We thank authors for their cooperation in this. 

 

3.2.2 Sensitive Language Choice 

 

Please be aware of the implications of certain lexical choices made in possibly sensitive contexts. The 

language used in submissions is expected to be socially conscious and free from prejudices concerning 

race, gender, disability, or sexual orientation. 

 

3.3 Other Style Conventions 

 

Please further note the following conventions that are standardised for the Journal. 

 

3.3.1 Lists 

 

 
1
 For footnotes, please ensure they are numbered continuously through your document. Use TNR 9, as here. Set the footnotes 

as aligned to ‘Justify’. 
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For lists, please indent them at 1.5cm on both left and right sides, with text starting at 2.25cm. If you 

wish to number them, then do so between brackets (e.g., (1), (2)). For example: 

 

(1) First element in the list, which reaches all the way past the end of the line and 

on to the next. 

(2) Second element in the list, which is shorter. 

 

Text following a list should not be indented, and should also adhere to the one TNR 11 line space rule. 

For linguistic examples, you should follow the same formatting as for a list. You may wish to include 

a sub-list, which should use bracketed letters and appear like the following: 

 

(3) (a) John kicked the ball. 

         (b) The ball was kicked by John. 

 

Linguistic examples requiring a gloss should be formatted as a list, and then follow the standard 

conventions for glossed examples, as set out by the Leipzig Glossing Rules. 

 

3.3.2 Quotations 

 

Use single quotation marks when selecting quotations from other sources, or for any scare quotes. 

Please bear in mind that long quotations should be avoided unless necessary, whereas shorter quotations 

are acceptable. Double quotation marks should only be used for translations (or where they might 

otherwise be conventionally used in linguistics). 

If a quotation that is three lines or longer is necessary, it should be formatted with one line  break 

(TNR 11) between it and the surrounding bodies of text. Indent the quotation at 1.5cm on both left and 

right sides. Use single quotation marks around it, and include the citation next to the quote: 

 

‘Long human words (the longer the better) were easy, unmistakable, and rarely 

changed their meanings [...] but short words were slippery, unpredictable, changing 

their meanings without any pattern.’ (Heinlein, 1961) 

 

Text following a long quote should not be indented, and should also adhere to the one TNR 11 line 

space rule. Quotations from another language should be followed by an English translation in [square 

brackets], both for in-line quotes and long quotes; please be sure to include translations for all languages 

used other than English. Also use square brackets contained with an ellipsis where a certain amount of 

text from the original source has been excluded to preserve flow.  

 

3.3.3 Dashes and Hyphens 

 

Use an en dash, and not a hyphen, between ranges of numbers, e.g., 2–9 (no spaces between). Please 

also bear this in mind for the page ranges of articles and chapters in the References. 

 

3.3.4 Commas and Abbreviations 

 

Follow e.g., and i.e., with commas. Please avoid using etc. where possible, though if used it shall not 

require a comma. Use of cf. will not require a comma either. Use of ibid. will only require a comma in 

an in-text citation with a page number (see Section 4 below). 

https://www.eva.mpg.de/lingua/pdf/Glossing-Rules.pdf
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3.3.5 Oxford Commas 

 

Use the Oxford (serial) comma for lists, e.g., milk, bread, and butter. Please note that the comma 

precedes the final item (or collocation) on the list and is followed by “and” (or “n/or”). 

 

3.3.6 Referring to Other Sections 

 

When referring up or down to various Sections in your paper, please capitalise the ‘S’ in ‘Sections’ and 

refer to the subsection appropriate, e.g., ‘see Section 3.1 for more’. Do not insert a full stop after the 

section number. 

 

3.3.7 Conventional Uses of Other Languages 

 

Note that conventional uses of Latin, French, or phrases from other languages within academic English 

need not be italicised. Examples may include: ‘et al.’, ‘ad hoc’, ‘a priori’, ‘a posteriori’, ‘a fortiori’, 

‘ibid.’, ‘vis-à-vis’, ‘qua’, ‘à choix’, etc. 

 

4 In-text Citation 
 

Any sources cited in the abstract must be given in full in the References. Unpublished results are not 

recommended in the References, but may be mentioned in the text. If such a source is included in the 

References, it should follow the standard reference style of the Journal and should include a substitution 

of the publication date with ‘Unpublished results’.  

Note that citation of a reference as ‘In prep.’ implies that the author has not yet finished their 

work (and might not appreciate their findings being shared); ‘In review’ implies that the author has 

submitted the paper but has not received feedback; and ‘In press’ implies that the item has been accepted 

for publication 

For in-text citation of other people’s work, make use of brackets, quotations marks, and page 

references where needed, according to the following format: 

 

● Hall (2001, p. 228) argues that ‘x’. 

● ‘X is y’ (Li, 1998, p. 41). 

● David (1979) discusses x. [use this while paraphrasing] 

● This is expressed in Ghosal (ibid., pp. 2-3). 

● In Van Humbolt (1836 [1999], p. 64), ‘x’. 

● Adger’s (2003) theory states x. 

 

Separate author name(s), years, and page numbers with a comma. Use ‘p. ’ (including the space) for 

single page references, and ‘pp. ’ for multiple page references. Note that translations or republications 

of older works should be doubly cited both in-text and in the end references. For multiple citations in 

brackets, separate with a semicolon, e.g., (Chang, 1997; Pieters et al., 2000). For more than two authors 

use ‘et al.’ in the in-text citation (but provide all author names in the end references), e.g., Podesva et 

al. (2002, p. 187). Use a full stop/period after ‘et al.’.  

For individuals using referencing software, both for in-text citations and reference lists (see 

Section 6), it will be useful to note that this Formatting and Styling Guide adheres closely to the APA 
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6th referencing style, only diverging on a few details (e.g., for republished works and publishing location 

of books).   

 

5 Tables and Figures 
 

Tables should be numbered consecutively, centred, and referred to in the body of your text, e.g., ‘Table 

1 shows x’. The table can be formatted as you like, as long as the text is in plain TNR 11; however, the 

heading should be positioned above the table, centred, and formatted as follows. Note that headings for 

tables and figures should be very brief and solely descriptive; data analysis from the contents of a table 

should occur in the main body of the text. 

 

Table 1: Heading in sentence case, italicised: Capital letter following a colon 

 

Insert table here, making sure it is centred and its edges do not exceed the standard 

margins set out for indented paragraphs above (1cm either side). 

 

Figures should be of an image with a high resolution: this could be a tree diagram, an image depicting 

experimental conditions, an example of a visual experimental stimulus, etc. To avoid copyright issues, 

please do not copy-paste images from other sources. The figures should be numbered consecutively, 

centred, and referred to in the body of your text, e.g., ‘Figure 1 shows x’. The caption is positioned at 

the bottom of the figure, centred and formatted as follows. 

 

Insert figure here, making sure it is centred and its edges do not exceed the margins set 

out for indented paragraphs above (1cm either side). 

 

Figure 1: Caption in sentence case, italicised, ending in a full stop/period. 

 

6 How To Reference for JoULAB 
 

Please insert a TNR 11 line break between the end of your writing and the end references (as below). 

The references should be in TNR 11 with a hanging indent of 1cm (with the top overlapping the bottom) 

and use 1.15 line spacing. Only give a list of references; do not provide a wider bibliography containing 

unreferenced work. Note that your reference Section should be titled ‘References’. 

 

6.1 References 

 

Please consult the following examples that demonstrate how to employ appropriate referencing 

conventions for the relevant source types. Note that a general pattern for each type has been given 

underlined to help as much as possible. For corpora, if the corpus is linked to a compiler/creator, start 

with their name; otherwise, start with the name of the corpus. 

 

(1) For journal articles:  

Author’s name, first name initial(s). (Year). Title of Article. Title of Journal/Periodical, volume(issue), 

page number-page number. 
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Blasi, D. E., Wichmann, S., Hammarstrom, H., Stadler, P. F., & Christiansen, M. H. (2016). Sound–

meaning association biases evidenced across thousands of languages. Proceedings in the 

National Academy of Sciences in the United States of America (PNAS), 113(39), 10818–10823. 

 

(2) For books: 

Author’s name, first name initial(s). (Year). Title of Book: Subtitle of Book. Location: Publisher. 

Editor’s name, first name initial(s). (Ed.). (Year). Title of Book: Subtitle of Book. Location: Publisher. 

Chomsky, N. (1980). Rules and Representations. New York: Columbia University Press. 

Kant, I. (1781 [1998]). Critique of Pure Reason (2nd ed.). (P. Guyer, & A. W. Wood Eds., Trans.) 

Cambridge: Cambridge University Press. 

Langacker, R. W. (1978). Foundations of Cognitive Grammar (Vol. I). Stanford: Stanford University 

Press. 

Von Humbolt, W. (1836 [1999]). On Language: On the Diversity of Human Language Construction 

and its Influence on the Mental Development of the Human Species. (M. Losonsky, Ed., & P. 

Heath, Trans.) Cambridge: Cambridge University Press. 

 

(3) For book chapters: 

Author’s name, first name initial(s). (Year). Title of Chapter or Short Text. In Editor’s first name 

initial(s) and surname (Ed.), Title of Book (pp. page numbers). Location: Publisher. 

Giora, R. (2012). The Psychology of Utterance Processing. In K. Allan, & K. Jaszczolt (Eds.), The 

Cambridge Handbook of Pragmatics (pp. 151–168). Cambridge: Cambridge University Press. 

 

(4) For online journals/archives/websites: 

Author’s name, first name initial(s). (date of publication, as detailed as possible). Title of 

Article/Archive/Website. Retrieved full date in DD/MM/YYYY, from Website: <web 

address/URL>. 

Meier-Oeser, S. (Summer 2011). Medieval Semiotics. (E. N. Zalta, Ed.) Retrieved 20/06/2020, from 

The Stanford Encyclopedia of Philosophy: < 

https://plato.stanford.edu/archives/sum2011/entries/semiotics-medieval/>. 

 

(5) Online Corpora: 

Davies, M. (2010-). The Corpus of Historical American English: 400 million words, 1810–2009. 

Retrieved 20/06/20, from <http://corpus.byu.edu/coha>. 

 

 (6) Dictionaries 

Crystal, D. (Ed.). (1992). An Encyclopaedic Dictionary of Language and Languages. Oxford, England: 

Blackwell.  

 

7 Appendices 
 

Any material supplementary or additional to the arguments, methodology, or results of your article can 

be included in the list of appendices, following your list of references. These might include, but are not 

limited to, annotations of corpus data, lists of frequently used acronyms in the article, questionnaires 

used in data collection, and transcriptions of various kinds. As far as possible, please keep appendices 

formatted in plain TNR 11, though it is understood that this may not always be possible. 

In this body of text, please give a brief summary of the contents of your appendices to ensure 

clarity as to why they have been included, and then number them accordingly: 

https://plato.stanford.edu/archives/sum2011/entries/semiotics-medieval/
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7.1 Appendix One 

 

Please ensure that the appendices Section is numbered in accordance with the numbering of the rest of 

your article (i.e., here it is Section 7). Appendices’ titles should be numbered lexically (e.g., ‘One’, 

‘Two’, ‘Three’, etc.) and not in Arabic numerals. 

 

About the Author(s) 
 

Do not number this Section, and delete (s) where appropriate. Leaving a TNR 11 line break after your 

list of references (or appendices, should your submission require them), please include a few pieces of 

personal information about yourself. This should include your name, year of study (or years since 

graduation; if you are recently graduated, please include your employment status/job title) affiliated 

institution(s), and research interests (where applicable). 
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